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Free alphabetical order worksheets

By Kathryn Hatashita-Lee Access your email’s sorting tools to alphabetize your contacts. Microsoft Outlook formats your contacts as a list of column entries sorted by last name or full name. Hotmail provides a Display Order list for a last name first or full name sequence. The Sort Order list alphabetizes your contact’s first
name or last name. Google Gmail offers a Sort By section with a choice of first name or last name order. Your alphabetized list will help you search your contacts’ data more quickly for future reference. Click “People” at the bottom of the Outlook screen, and then select the “View” tab on the command ribbon. Tap the
“Change View” arrow in the Current View group, and then click “List.” Click the “File As” column heading to sort your contacts by last name. If the list displays in reverse alphabetical order, click the “File As” heading again to alphabetize the list. To sort your contacts by the full name beginning with the first name, click the
“Full Name” column header. Log in to your Microsoft Account and then click the Outlook arrow button. Tap “People” to display your contacts list. Click the Gear button next to your name on the menu bar. Click to add a black bullet next to the preferred name order option in the Display Order section: “First Last” or “Last,
First.” Click to add a bullet next to the preferred option in the Sort Order section: “First name” or “Last name.” Click outside the menu to hide the Gear menu. Open your Google Gmail account and then click the “Gmail” down-arrow. Click the “More” button and then select “First name” or “Last name” in the Sort By section
to sort your contacts list. Keep up with the latest daily buzz with the BuzzFeed Daily newsletter! If you have a large number of worksheets in your Excel workbook, it may be hard to find a specific worksheet. Sorting your worksheet tabs alphabetically would make it easier to find what your looking for. RELATED: How to
Rename Worksheet Tabs in Excel In addition to organizing your worksheet tabs by applying colors to them, you can also sort them alphabetically or alphanumerically, as long as you’ve applied custom names to your worksheets. Unfortunately, sorting worksheet tabs alphabetically is not built in to Excel, but you can add a
macro to your workbook that will allow you to sort your tabs in ascending or descending order. We’ll show you how to add a macro available on Microsoft’s support site to your Excel workbook that will sort your worksheet tabs. To begin, press Alt+F11 to open the Microsoft Visual Basic for Applications (VBA) editor. Then,
go to Insert > Module. Copy and paste the following macro from Microsoft into the module window that displays. Sub Sort_Active_Book() Dim i As Integer Dim j As Integer Dim iAnswer As VbMsgBoxResult ' ' Prompt the user as which direction they wish to ' sort the worksheets. '    iAnswer = MsgBox("Sort Sheets in
Ascending Order?" & Chr(10) _      & "Clicking No will sort in Descending Order", _      vbYesNoCancel + vbQuestion + vbDefaultButton1, "Sort Worksheets")    For i = 1 To Sheets.Count       For j = 1 To Sheets.Count - 1 ' ' If the answer is Yes, then sort in ascending order. '         If iAnswer = vbYes Then             If
UCase$(Sheets(j).Name) > UCase$(Sheets(j + 1).Name) Then                Sheets(j).Move After:=Sheets(j + 1)             End If ' ' If the answer is No, then sort in descending order. '          ElseIf iAnswer = vbNo Then             If UCase$(Sheets(j).Name) < UCase$(Sheets(j + 1).Name) Then                Sheets(j).Move
After:=Sheets(j + 1)             End If          End If       Next j    Next i End Sub The VBA editor automatically names each module with a number on the end, such as Module1, Module2, etc. You can simply accept the default name of the module. However, if you plan to add other macros to your workbook, it’s a good idea to
rename each module so you know what they are. We’ll rename our module to show you how. To rename the module, select the text in the Name box for the module under Properties in the left pane. Type a name for the module in the Name box and press Enter. Note that the module name cannot contain spaces. The
name of the module changes in the Modules list under Project in the left pane. Close the VBA editor by going to File > Close and Return to Microsoft Excel. Now, we’re going to run the macro to sort our tabs. Press Alt+F8 to access the list of macros on the Macro dialog box. Select the macro in the list (in our case there
is only one macro), and click “Run”. The following dialog box displays, allowing you to choose whether you want to sort your worksheets in ascending or descending order. We want to sort them in ascending order, so we click “Yes”. The worksheet tabs are now arranged in alphabetical order. The macro you added is part
of your workbook now, but when you save it, you’ll probably see the following dialog box. That’s because you saved your workbook as an .xlsx file, which is a normal Excel workbook format that does not include macros. To include macros in your workbook, and be able to run them, you must save your workbook as a
macro-enabled workbook, or an .xlsm file. To do this, click “No” on this dialog box. The Save As dialog box displays. Navigate to where you want to save the macro-enabled workbook, if you’re not already in that folder. Select “Excel Macro-Enabled Workbook (*.xlsm)” from the “Save as type” drop-down list. Click “Save”.
If you don’t save the workbook as a macro-enabled workbook (.xlsm file), the macro you added will be deleted. You might want to delete the .xlsx version of your workbook so you don’t forget to use the .xlsm version of your workbook if you want to add more worksheet tabs and sort them again using the macro. You can
always save the workbook as an .xlsx file again if you don’t want to use macros anymore. Yev Haidamaka/ Rd.comAs English speakers, it’s pretty much a guarantee that we have the alphabet ingrained in our memory, in order, from a very young age. You can probably say the ABCs at rapid speed without even thinking
about it, and some people can even say them backwards. We certainly can’t imagine the alphabet being in any other order… but why is it in that order in the first place?When you think about it, it doesn’t really make sense. It’s not arranged by vowels and consonants, similar sounds, or how often the letters are used.
(That actually varies by language; on French keyboards, the letter “Q” is where our “A”s are. Here’s the full explanation for the location of our letters on the keyboard.)So how did the order we know today come to be? There’s really not an easy answer. No one woke up and decided to put the letters in that order; the
alphabet evolved slowly over a long period of time to become what it is today. In fact, here are the six letters you never knew that our alphabet lost along the way. Our alphabet can be traced all the way back to ancient Egypt, where foreign workers developed alphabetic lettering while the Egyptians themselves were still
using hieroglyphics. This first alphabet was adapted by the Phoenicians, whose Mediterranean civilization thrived from 1500 to 300 BC. The Greeks then began using it around the 8th century BC, and we have them to thank for vowels. (And birthday cake, but that’s a whole ‘nother story.)From Greece, our alphabet
traveled to Rome, and it’s the Romans who turned it into the “modern” alphabet, with letters we recognize today. The University of Maryland made a seriously cool animation that visualizes the alphabet’s evolution. As you can see, while the individual letters changed quite a bit, the order as a whole has stayed pretty
much the same, with only a couple exceptions. The Romans took “Z,” which was near the beginning of the Greek alphabet as “zeta” but had since disappeared, and tacked it onto the end of their alphabet. They also did something similar with “Y.” (Neither of those, however, was actually the last letter added to the
alphabet—this letter was.)So why that specific order? Well, we actually don’t know for sure. Some scholars theorize that it was based off of the order of Egyptian hieroglyphics. One of the most popular theories suggests that there was a numerical component; each letter had a number equivalent, and those have just
been lost over time. Others have theorized that the order came from a mnemonic device meant to help people remember it—some kind of sentence where each letter became a full word, like the technique you used in school to remember the order of the planets. Can you imagine what a 26-odd-letter mnemonic device
would be like, though? (We can!) Personally, we much prefer the song!And I know what you’re thinking; no, the letters weren’t put into that order to fit the song. The tune already existed, in the form of “Twinkle Twinkle Little Star,” “Baa Baa Black Sheep,” and a French folk song widely considered to be the earliest version.
In fact, considering that the alphabet order and the song tune already existed, it’s pretty impressive that they matched up so well! Next, learn the science behind why some songs get stuck in your head.[Source: mentalfloss.com] The modern keyboard is not arranged in alphabetical order because millions of users have
already learned the QWERTY keyboard layout, which is named after the first six letters in the top row of keys. The reason behind the development of the QWERTY layout as opposed to an alphabetical layout is debated, but two primary theories are accepted explanations. The most popular explanation claims that the
key positioning was designed to slow down typists because the early typewriter's mechanical design resulted in jammed keys and components. A recently emerged theory argues that the QWERTY layout was designed to facilitate Morse code receivers because the alphabetical layout was inefficient when translating
incoming codes from the telegraph. The first keyboard patented by Christopher Latham Sholes in 1868 had the keys alphabetically arranged. The first documented appearance of the QWERTY keyboard is found in U.S. Patent No. 207,559 and was issued in 1878 to Sholes. Sholes and his partners sold their design for a
typewriter and its keyboard to Remington & Sons, who manufactured the first commercial typewriter. In 1893, Remington and the other four largest typewriter manufacturers, Caligraph, Yost, Densmore and Smith-Premier, merged to form the Union Typewriter Company and agreed to adopt the QWERTY layout as the
standard. Connect the dots worksheets, also called dot to dot, is a great activity to teach your children or students counting and the alphabet or as a fun way to reinforce these skills. Because the connect the dots worksheets are a puzzle and reveal fun pictures, the kids will really love doing them. The connect the dot
worksheets are arranged by skill level - easy, medium, and hard. They are also put into categories so you can easily find connect the dot worksheets for counting, the lowercase ​and uppercase alphabet, and skip counting.​ All of these connect the dots worksheets are free and they can be printed out and handed over to
your child. I also have a list of online connect the dots games that can all be played on the computer. You can find more free printable activities for kids including color by number worksheets, hidden picture worksheets, and printable mazes. In mathematics, the order of operations is the order in which factors in an
equation are solved when more than one operations exist in the equation. The correct order of operations across the entire field is as follows: Parenthesis/Brackets, Exponents, Division, Multiplication, Addition, Subtraction. Teachers hoping to educate young mathematicians on this principle should emphasize the
importance of the sequence in which an equation is solved, but also make it fun and easy to remember the correct order of operations, which is why many teachers use the acronym PEMDAS along with the phrase "Please Excuse My Dear Aunt Sally" to help students remember the proper sequence. Huntstock/Getty
Images In the ​first order of operations worksheet (PDF), students are asked to solve problems which put their understanding of the rules and meaning of PEMDAS to the test. However, it's important to also remind students that the order of operations includes the following specifics: Calculations must be done from left to
right. Calculations in brackets (parenthesis) are done first. When you have more than one set of brackets, do the inner brackets first. Exponents (or radicals) must be done next. Multiply and divide in the order the operations occur. Add and subtract in the order the operations occur. Students should be encouraged to
simply inside groupings of parentheses, brackets, and braces first, working from the innermost part first then moving outward and simplify all exponents.  The second order of operations worksheet (PDF) continues this focus on understanding the rules of the order of operations, but can be tricky for some students who
are new to the subject. It is important for teachers to explain what would happen if the order of operations is not followed which could drastically impact the solution to the equation. Take question three in the linked PDF worksheet—if the student were to add 5+7 before simplifying the exponent, they might try to simplify
123 (or 1733), which is much higher than 7​3+5 (or 348) and the resulting outcome would be even higher than the correct answer of 348. Use this order of operations worksheet (PDF) to further test your students, which ventures into multiplication, addition, and exponentials all inside of parentheticals, which can further
confuse students who might forget that the order of operations essentially resets within parentheticals and must then occur outside of them. Look at question 12 in the linked printable worksheet—there are addition and multiplication operations that need to occur outside of the parenthesis and there are addition, division,
and exponentials inside the parenthesis. According to the order of operations, students would solve this equation by first resolving the parenthesis, which would begin with simplifying the exponential, then dividing it by 1 and adding 8 to that result. Finally, the student would multiply the solution to that by 3 then add 2 to
get an answer of 401. Use the fourth,  fifth, and sixth printable PDF worksheets to completely test your students on their comprehension of the order of operations. These challenge your class to use comprehension skills and deductive reasoning to determine how to properly solve these problems. Many of the equations
have multiple exponentials so it's important to allow your students plenty of time to complete these more complex math problems. Answers for these worksheets, like the rest linked on this page, are on the second page of each PDF document—make sure you don't hand them out to your students instead of the test!
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